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Introduction

This manual describes how to connect the Display and the External Device (target PLC).

In this manual, the connection procedure will be described by following the below sections:

1 System Configuration

This section shows the types of External 

Devices which can be connected and SIO 

type.

"1 System Configuration" (page 3)

2 Selection of External Device

Select a model (series) of the External 

Device to be connected and connection 

method.

"2 Selection of External Device" (page 7)

3 Example of Communication Settings

This section shows setting examples for 

communicating between the Display and 

the External Device.

"3 Example of Communication Setting" 
(page 8)

4 Setup Items

This section describes communication 

setup items on the Display.

Set communication settings of the Display 

with GP-Pro Ex or in offline mode.

"4 Setup Items" (page 15)

5 Cable Diagram

This section shows cables and adapters 

for connecting the Display and the 

External Device.

"5 Cable Diagram" (page 20)

Operation
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1 System Configuration

The system configuration in the case when the External Device of Fuji Electric Co., Ltd. and the Display are 

connected is shown.

 Connection Configuration

• 1:1 Connection

Series CPU Link I/F SIO Type
Setting 

Example

Cable 

Diagram

SPH

SPH200
(NP1PH-08 / 
NP1PH-16)

SPH300
(NP1PS-32 / 
NP1PS-32R / 
NP1PS-74 / 
NP1PS-74R / 
NP1PS-117 / 
NP1PS-117R)

SPH2000
(NP1PM-48E)

Loader Connection 
Connector on CPU unit

RS232C
"Setting 
Example 1" 
(page 8)

"Cable 
Diagram 1" 
(page 20)

NP1L-RS1

RS232C
"Setting 
Example 2" 
(page 9)

"Cable 
Diagram 2" 
(page 22)

RS422/485
(4wire)

"Setting 
Example 3" 
(page 10)

"Cable 
Diagram 3" 
(page 24)

NP1L-RS2 RS232C
"Setting 
Example 2" 
(page 9)

"Cable 
Diagram 2" 
(page 22)

NP1L-RS4
RS422/485
(4wire)

"Setting 
Example 3" 
(page 10)

"Cable 
Diagram 3" 
(page 24)

NP1L-TL1 + FFK120A-C10 
(RS232C interface)*1

*1 Version 0604 or later interface is required.

RS232C
"Setting 
Example 4" 
(page 11)

"Cable 
Diagram 4" 
(page 30)

NP1L-TL1 + FFK120A-C10 
(RS485 interface)*1

RS422/485
(4wire)

"Setting 
Example 5" 
(page 13)

"Cable 
Diagram 5" 
(page 32)

• Only one Display can be connected to one CPU or one Link I/F’s SIO port.

• When 2 or more displays are connected to 2 or more CPUs and Link I/F’s SIO ports, the error 

below may be displayed when 2 or more Displays are activated simultaneously.

“Error has been responded for initial communication command (Error Code: [Hex])”

If an error occurs, wait for 5 or more seconds to activate the Display.

Display
External Device
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 IPC COM Port

When connecting IPC with an External Device, the COM port used depends on the series and SIO type. Please 

refer to the IPC manual for details.

Usable port

Series
Usable Port

RS-232C RS-422/485(4 wire) RS-422/485(2 wire)

PS-2000B
COM1*1 , COM2, 
COM3*1, COM4

*1 The RI/5V can be switched. Use the IPC’s switch to change if necessary.

- -

PS-3450A, PS-3451A,
PS3000-BA, PS3001-BD

COM1, COM2*1*2 COM2*1*2 COM2*1*2

PS-3650A (T41 model),
PS-3651A (T41 model)

COM1*1 - -

PS-3650A (T42 model),
PS-3651A (T42 model)

COM1*1*2, COM2 COM1*1*2 COM1*1*2

PS-3700A (Pentium®4-M)
PS-3710A

COM1*1, COM2*1, 
COM3*2 , COM4

*2 Set up the SIO type with the DIP Switch. Please set up as follows according to SIO type to be used.

COM3*2 COM3*2

PS-3711A COM1*1, COM2*2 COM2*2 COM2*2

PS4000*3 COM1, COM2 - -

PL3000
COM1*1*2, COM2*1, 
COM3, COM4

COM1*1*2 COM1*1*2

PE-4000B Atom N270 COM1, COM2 - -

PE-4000B Atom N2600 COM1, COM2
COM3*4 , COM4*4, 
COM5*4, COM6*4

COM3*4, COM4*4, 
COM5*4, COM6*4

PS5000 (Slim Panel Type 
Core i3 Model) *5 *6 COM1, COM2*4 COM2*4 COM2*4

PS5000 (Slim Panel Type 
Atom Model) 
*5 *6

COM1, COM2*7 COM2*7 COM2*7

PS5000 (Enclosed Panel 
Type)*8 COM1 - -

PS5000 (Modular Type 
PFXPU/PFXPP)*5 *6

PS5000 (Modular Type 
PFXPL2B5-6)

COM1*7 COM1*7 COM1*7

PS5000 (Modular Type 
PFXPL2B1-4)

COM1, COM2*7 COM2*7 COM2*7

PS6000 (Advanced Box)
PS6000 (Standard Box)

COM1*9 *10 *10

PS6000 (Basic Box) COM1*9 COM1*9 COM1*9
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DIP Switch settings (PL3000 / PS3000 Series)

RS-232C

*3 When making communication between an External Device and COM port on the Expansion slot,             
only RS-232C is supported. However, ER (DTR/CTS) control cannot be executed because of the             
specification of COM port.
For connection with External Device, use user-created cables and disable Pin Nos. 1, 4, 6 and 9.
Please refer to the IPC manual for details of pin layout.

*4 Set up the SIO type with the BIOS. Please refer to the IPC manual for details of BIOS.

*5 When setting up communication between an External Device and the RS-232C/422/485 interface           
module, use the IPC (RS-232C) or PS5000 (RS-422/485) cable diagrams. However, when using            
PFXZPBMPR42P2 in a RS-422/485 (4-wire) configuration with no flow control, connect 7.RTS+           
and 8.CTS+, and connect 6.RTS- and 9.CTS-.
When using RS-422/485 communication with External Devices, you may need to reduce the            
transmission speed and increase the TX Wait time.

*6 To use RS-422/485 communication on the RS-232C/422/485 interface module, the DIP Switch           
setting is required. Please refer to "Knowledge Base" (FAQs) on the support site. (http://www.pro-             
face.com/trans/en/manual/1001.html)

*7 Set up the SIO type with the DIP Switch. Please refer to the IPC manual for details of DIP Switch.
The BOX Atom has not a switch to set the RS-232C, RS-422/485 mode. Use the BIOS for the                 
setting.

*8 For the connection with the External Device, on the user-created cable read as if the connector on                
the Display-side is a M12 A-coding 8 pin socket. The pin assignment is the same as described in                 
the cable diagram. For the M12 A-coding connector, use PFXZPSCNM122.

*9 In addition to COM1, you can also use the COM port on the optional interface.

*10 Install the optional interface in the expansion slot.

DIP Switch Setting Description

1 OFF*1

*1 When using PS-3450A, PS-3451A, PS3000-BA and PS3001-BD, turn ON the set value.

Reserved (always OFF)

2 OFF
SIO type: RS-232C

3 OFF

4 OFF Output mode of SD (TXD) data: Always output

5 OFF Terminal resistance (220)  insertion to SD (TXD): None

6 OFF Terminal resistance (220)  insertion to RD (RXD): None

7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available

8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available

9 OFF
RS (RTS) Auto control mode: Disabled

10 OFF

Settings FAQ ID

PFXZPBMPR42P2, RS422/485 change method FA263858

PFXZPBMPR42P2 termination resistor setting FA263974

PFXZPBMPR44P2, RS422/485 change method FA264087

PFXZPBMPR44P2 termination resistor setting FA264088
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RS-422/485 (4 wire)

RS-422/485 (2 wire)

DIP Switch Setting Description

1 OFF Reserved (always OFF)

2 ON
SIO type: RS-422/485

3 ON

4 OFF Output mode of SD (TXD) data: Always output

5 OFF Terminal resistance (220)  insertion to SD (TXD): None

6 OFF Terminal resistance (220)  insertion to RD (RXD): None

7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available

8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available

9 OFF
RS (RTS) Auto control mode: Disabled

10 OFF

DIP Switch Setting Description

1 OFF Reserved (always OFF)

2 ON
SIO type: RS-422/485

3 ON

4 OFF Output mode of SD (TXD) data: Always output

5 OFF Terminal resistance (220)  insertion to SD (TXD): None

6 OFF Terminal resistance (220)  insertion to RD (RXD): None

7 ON Short-circuit of SDA (TXA) and RDA (RXA): Available

8 ON Short-circuit of SDB (TXB) and RDB (RXB): Available

9 ON
RS (RTS) Auto control mode: Enabled

10 ON
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2 Selection of External Device

Select the External Device to be connected to the Display.

Setup Items Setup Description

Number of Devices/
PLCs

Enter an integer from 1 to 4 to define the number of Devices/PLCs to connect to the 
display.

Manufacturer Select the manufacturer of the External Device to connect. Select "Fuji Electric Co., Ltd.".

Series

Select the External Device model (series) and the connection method. Select "MICREX-
SX Series SIO".
In System configuration, make sure the External Device you are connecting is supported by 
"MICREX-SX Series SIO" in system configuration.

"1 System Configuration" (page 3)

Port Select the Display port to be connected to the External Device.

Use System Area

Check this option to synchronize the system data area of the Display and the device 
(memory) of the External Device. When synchronized, you can use the External Device’s 
ladder program to switch the display or display the window on the Display.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
This feature can also be set in GP-Pro EX or in the Display's offline mode.

Cf. GP-Pro EX Reference Manual "System Settings [Display Unit] - [System 
Area] Settings Guide"

Cf. Maintenance/Troubleshooting Guide "Main Unit - System Area Settings"



MICREX-SX Series SIO Driver   

GP-Pro EX Device/PLC Connection Manual 8

3 Example of Communication Setting

Examples of communication settings of the Display and the External Device, recommended by Pro-face, are 

shown.

3.1 Setting Example 1

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] .

 Settings of External Device

Communication setting of External Device is fixed, so setting is not necessary.
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3.2 Setting Example 2

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] .

 Settings of External Device

Communication setting of External Device is fixed, so setting is not necessary.

Set the [Mode] switch of the link I/F unit to "1" (loader mode).



MICREX-SX Series SIO Driver   

GP-Pro EX Device/PLC Connection Manual 10

3.3 Setting Example 3

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] .

 Settings of External Device

Communication setting of External Device is fixed, so setting is not necessary.

Set the [Mode] switch of the link I/F unit to "2" (loader mode).
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3.4 Setting Example 4

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] .
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 Settings of External Device

Turn ON the DIP switch No.8 "Initialization method" on the rear panel of general-purpose interface module of the 

External Device. Use the rotary switch for MODE setting. Refer to your External Device manual for details.

Settings of Character Configuration Switch

Baud Rate Setting Switch

No. Setup Value Setup Description

1 OFF

Unused2 OFF

3 OFF

4 ON Stop bit length = 1

5 OFF Data bit length = 8

6 ON Parity bit = Even

7 ON Parity bit = Enable

8 ON Switch setting effective

No. Setup Value Setup Description

1 OFF

Always set to OFF.

2 OFF

3 OFF

4 OFF

5 OFF

6 OFF

7 ON Baud rate = 19200

8 OFF Unused

Setup Items Setup Value Notes

MODE switch 1 RS-232C 1:1

T-LINK No. 1 Station No. 1

T-LINK Termination 
Resistance

ON Termination resistance: ON
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3.5 Setting Example 5

 Settings of GP-Pro EX

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] .



MICREX-SX Series SIO Driver   

GP-Pro EX Device/PLC Connection Manual 14

 Settings of External Device

Turn ON the DIP switch No.8 "Initialization method" on the rear panel of general-purpose interface module of the 

External Device. Use the rotary switch for MODE setting. Refer to your External Device manual for details.

Settings of Character Configuration Switch

Baud Rate Setting Switch

No. Setup Value Setup Description

1 OFF

Unused2 OFF

3 OFF

4 ON Stop bit length = 1

5 OFF Data bit length = 8

6 ON Parity bit = Even

7 ON Parity bit = Enable

8 ON Switch setting effective

No. Setup Value Setup Description

1 OFF

Always set to OFF.

2 OFF

3 OFF

4 OFF

5 OFF

6 OFF

7 ON Baud rate = 19200

8 OFF Unused

Setup Items Setup Value Notes

MODE switch 3 RS-485 1:N

T-LINK No. 1 Station No. 1

T-LINK Termination 
Resistance

ON Termination resistance: ON

RS-485 No. 0 Station No. 0

RS-485 Termination 
Resistance

ON Termination resistance: ON
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4 Setup Items

Set communication settings of the Display with GP-Pro EX or in offline mode of the Display.

The setting of each parameter must be identical to that of External Device.

"3 Example of Communication Setting" (page 8)

4.1 Setup Items in GP-Pro EX

 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Setup Items Setup Description

SIO Type Select the SIO type to communicate with the External Device.

Speed Select speed between the External Device and the Display.

Data Length Select data length.

Parity Select how to check parity.

Stop Bit Select stop bit length.

Flow Control
Select the communication control method to prevent overflow of transmission and 
reception data.

Timeout
Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the 
response from the External Device.

Retry
In case of no response from the External Device, use an integer from 0 to 255 to enter how 
many times the Display retransmits the command.

Wait To Send
Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving 
packets to transmitting next commands.
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 Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] .

Set [Individual Device Settings] when using variable data.

"6.4 When Using a Variable" (page 47)

RI/VCC
You can switch RI/VCC of the 9th pin when you select RS232C for SIO type.
It is necessary to change RI/5V by changeover switch of IPC when connect with IPC. 
Please refer to the manual of the IPC for more detail.

• Refer to the GP-Pro EX Reference Manual for Indirect Device.

Cf. GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect 
Device)"

Setup Items Setup Description

Connected to FFK120A Put a check in the box when connecting FFK120A.

Use Variable Data Put a check in the box when using variable data.

Variable Data Select variable data.

Setup Items Setup Description
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4.2 Setup Items in Offline Mode

 Communication Settings

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings] in offline mode. Touch the 

External Device you want to set from the displayed list.

• Refer to the Maintenance/Troubleshooting Guide for information on how to enter offline 

mode or about the operation.

Cf. Maintenance/Troubleshooting Guide "Offline Mode"

• The number of the setup items to be displayed for 1 page in the offline mode depends on the 

Display in use. Please refer to the Reference manual for details.

Setup Items Setup Description

SIO Type

Select the SIO type to communicate with the External Device.

To make the communication settings correctly, confirm the serial interface specifications of 
Display unit for [SIO Type].
We cannot guarantee the operation if a communication type that the serial interface does 
not support is specified.
For details concerning the serial interface specifications, refer to the manual for Display 
unit.

Speed Select speed between the External Device and the Display.

Data Length Select data length.

Parity Select how to check parity.

Stop Bit Select stop bit length.

Flow Control
Select the communication control method to prevent overflow of transmission and 
reception data.
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 Device Setting

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device 

you want to set from the displayed list, and touch [Device].

Timeout
Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the 
response from the External Device.

Retry
In case of no response from the External Device, use an integer from 0 to 255 to enter how 
many times the Display retransmits the command.

Wait To Send
Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving 
packets to transmitting next commands.

Setup Items Setup Description

Device/PLC Name
Select the External Device for device setting. Device name is a title of External Device set 
with GP-Pro EX.(Initial value [PLC1])

Connected to FFK120A Displays the connection state with FFK120A.

Setup Items Setup Description
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 Option

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Equipment Settings]. Touch the 

External Device you want to set from the displayed list, and touch [Option].

Setup Items Setup Description

RI/VCC
Switches RI/VCC of the 9th pin.
It is necessary to change RI/5V by changeover switch of IPC when connect with IPC. 
Please refer to the manual of the IPC for more detail.

• GP-4100 series, GP-4*01TM and GP-Rear Module do not have the [Option] setting in the 

offline mode.
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5 Cable Diagram

The cable diagram shown below may be different from the cable diagram recommended by Fuji Electric Co., Ltd.. 

Please be assured there is no operational problem in applying the cable diagram shown in this manual.

• The FG pin of the External Device body must be D-class grounded. Please refer to the manual of the External 

Device for more details.

• SG and FG are connected inside the Display. When connecting SG to the External Device, design the system 

not to form short-circuit loop.

• Connect the isolation unit, when communication is not stabilized under the influence of a noise etc.

Cable Diagram 1

Display

(Connection Port)
Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
SP5000*2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 Series and GP-4203T

*2 Except SP-5B00

*3 Only the COM port which can communicate by RS-232C can be used.
" IPC COM Port" (page 4)

1A

Connection adapter by Fuji Electric Co., Ltd. 
NW0H-CNV

+
Connection cable by Fuji Electric Co., Ltd.*4 

NP4H-CB2 (2m)

*4 CPU versions that support NP4H-CB2 are as follows:
SPH200
  NP1PH-08 / NP1PH-16: lower than V22
SPH300
  NP1PS-32: lower than V22
  NP1PS-32R / NP1PS-74R / NP1PS-117R: lower than V26
  NP1PS-74 / NP1PS-117: All versions
SPH2000
  NP1PM-48E: lower than V25

GP-4105 (COM1)
GP-4115T (COM1)
GP-4115T3 (COM1)

1B

User-created cable
+

Connection adapter by Fuji Electric Co., Ltd. 
NW0H-CNV

+
Connection cable by Fuji Electric Co., Ltd.*4 

NP4H-CB2 (2m)
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1A)

1B)

D-sub 9 pin

Display
External Device

NW0H-CNV

NP4H-CB2 (2m)

Half-pitch

D-sub 9 pin

External Device
NW0H-CNV

NP4H-CB2 (2m)

Half-pitch

Display

Display side
Terminal block

Signal
name

RD(RXD)
SD(TXD)
ER(DTR)

SG
RS(RTS)
CS(CTS)

External Device side
D-sub 9 pin (plug)

Pin

2
3
4
5
7
8

RD(RXD)
SD(TXD)
ER(DTR)

SG
RS(RTS)
CS(CTS)

Shield
Signal
name

User-created cable
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Cable Diagram 2

2A)

Display

(Connection Port)
Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
SP5000*2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 Series and GP-4203T

*2 Except SP-5B00

*3 Only the COM port which can communicate by RS-232C can be used.
" IPC COM Port" (page 4)

2A User-created cable The cable length must be 15m or less.

GP-4105 (COM1)
GP-4115T (COM1)
GP-4115T3 (COM1)

2B User-created cable The cable length must be 15m or less.

Shield

CD

RD(RXD)

SD(TXD)

ER(DTR)

SG

DR(DSR)

RS(RTS)

CS(CTS)

FG

RS

SD

RD

CS

SG

DR

CD

ER

FG

1

2

3

4

5

6

7

8

Shell

Signal namePin Signal namePin

Display side
D-sub 9 pin (socket)

7

3

2

8

5

6

1

4

Shell

External Device side
D-sub 9 pin (plug)

User-created cable

Display
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2B)

Shield

CD

RD(RXD)

SD(TXD)

ER(DTR)

SG

DR(DSR)

RS(RTS)

CS(CTS)

RS

SD

RD

CS

SG

DR

CD

ER

FG

Signal name Signal namePin

7

3

2

8

5

6

1

4

Shell

External Device side
D-sub 9 pin (plug)

User-created cable

Display side 
Terminal block

Display
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Cable Diagram 3

Display

(Connection Port)
Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module 
(COM1)
ST3000*2 (COM2)
LT3000 (COM1)
IPC*3

*1 All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

3A

COM port conversion adapter by Pro-face
CA3-ADPCOM-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length must 
be 1000m or less.

Termination resistance 
switch on the 
communication 
module should be set 
"3".3B User-created cable

GP3000*4 (COM2)

3C

Online adapter by Pro-face
CA4-ADPONL-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length must 
be 1000m or less.

Termination resistance 
switch on the 
communication 
module should be set 
"3".3D

Online adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

GP-4106 (COM1)
GP-4116T (COM1)

3E User-created cable

The cable length must 
be 1000m or less.

Termination resistance 
switch on the 
communication 
module should be set 
"3".

GP4000*5 (COM2)
GP-4201T (COM1)
SP5000*6 (COM1/2)
SP-5B00 (COM2)
ST6000*7 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000*8 (COM2)
PS6000 (Basic Box) 
(COM1/2)

3F

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1*9

+
User-created cable

The cable length must 
be 1000m or less.

Termination resistance 
switch on the 
communication 
module should be set 
"3".

3B User-created cable

PE-4000B*10

PS5000*10

PS6000 (Optional 
Interface)*10

3G User-created cable

The cable length must 
be 1000m or less.

Termination resistance 
switch on the 
communication 
module should be set 
"3".
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*3 Only the COM port which can communicate by RS-422/485 (4 wire) can be used.  (Except PE-4000B, PS5000,                 
and PS6000)
" IPC COM Port" (page 4)

*4 All GP3000 models except GP-3200 series and AGP-3302B

*5 All GP4000 models except GP-4100 Series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*6 Except SP-5B00

*7 Except ST-6200

*8 Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display                  
side of the cable diagram.

*9 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block             
Conversion Adapter, refer to Cable Diagram 3A.

*10 Only the COM port which can communicate by RS-422/485 (4 wire) can be used.
" IPC COM Port" (page 4)
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3A)

* Termination resistance switch on the communication module should be set "3".

3B)

* Termination resistance switch on the communication module should be set "3".

SDA

SDB

RDA

RDB

SG

SDA

SDB

FG

2

1

9

8

5

4

3

6

External Device side
D-sub 9 pin (socket)Shield

Signal nameTERM

RDA

RDB

SDA

SDB

SG

FG

Signal name

Pin

Display side

User-created cable

CA3-ADPTRM-01

CA3-ADPCOM-01Display

Shield

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

FG

SDA

SDB

RDA

RDB

SG

SDA

SDB

FG

1

2

3

7

5

4

8

9

6

Shell

Signal namePin

Display side
D-sub 9 pin (socket)

2

1

9

8

5

4

3

6

Signal namePin

External Device side
D-sub 9 pin (socket)

Termination resistance
100Ω (1/2W)

User-created cable

Display
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3C)

* Termination resistance switch on the communication module should be set "3".

3D)

* Termination resistance switch on the communication module should be set "3".

SDA

SDB

RDA

RDB

SG

SDA

SDB

FG

2

1

9

8

5

4

3

6

External Device side
D-sub 9 pin (socket)Shield

Signal nameTERM

RDA

RDB

SDA

SDB

SG

FG

Signal name

Pin

Display side

CA3-ADPTRM-01

CA4-ADPONL-01Display

User-created cable

Shield
TREMRX

RDA

RDB

SDA

SDB

SG

TERMTX

FG

SDA

SDB

RDA

RDB

SG

SDA

SDB

FG

1

2

7

3

8

5

9

Shell

Signal namePin

Display side
D-sub 9 pin (plug)

2

1

9

8

5

4

3

6

Signal namePin

External Device side
D-sub 9 pin (socket)

CA4-ADPONL-01Display

User-created cable
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3E)

* Termination resistance switch on the communication module should be set "3".

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.  

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

Shield

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

SDA

SDB

RDA

RDB

SG

SDA

SDB

FG

Signal name

2

1

9

8

5

4

3

6

Signal namePin

External Device side
D-sub 9 pin (socket)

Termination 
resistance*1

User-created cable

Display side 
Terminal block

Display
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3F)

* Termination resistance switch on the communication module should be set "3".

3G)

* Termination resistance switch on the communication module should be set "3".

SDA 

SDB 

RDA 

RDB 

SG 

SDA 

SDB 

FG 

2 

1 

9 

8 

5 

4 

3 

6 

External Device side
D-sub 9 pin (socket) Shield 

Signal name TERM 

RDA 

RDB 

SDA 

SDB 

SG 

FG 

Signal name 

Pin 

Display side 

User-created cable 

PFXZCBADTM1

Display 

Shield

Rx+

Rx-

Tx+

Tx-

GND

NC

NC

NC

NC

FG

SDA

SDB

RDA

RDB

SG

SDA

SDB

FG

3

4

2

1

5

7

8

9

6

Shell

Signal namePin

Display side
D-sub 9 pin (socket)

2

1

9

8

5

4

3

6

Signal namePin

External Device side
D-sub 9 pin (socket)

Termination resistance
100Ω (1/2W)

User-created cable

Display
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Cable Diagram 4

4A)

* Set the operation mode on the External Device interface to 1.

Display

(Connection Port)
Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
SP5000*2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 Series and GP-4203T

*2 Except SP-5B00

*3 Only the COM port which can communicate by RS-232C can be used.
" IPC COM Port" (page 4)

4A
RS232C cable by Pro-face
CA3-CBL232/5M-01 (5m)

Set the operation mode on the 
interface to 1.

4B User-created cable

GP-4105 (COM1)
GP-4115T (COM1)
GP-4115T3 (COM1)

4C User-created cable
Set the operation mode on the 
interface to 1.

Display

CA3-CBL232/5M-01

RS232C

External Device*
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4B)

* Set the operation mode on the External Device interface to 1.

4C)

* Set the operation mode on the External Device interface to 1.

Shield

CD

RD(RXD)

SD(TXD)

ER(DTR)

SG

RS(RTS)

CS(CTS)

RTS

SD

RD

CTS

SG

CD

ER

DSR

FG

1

2

3

4

5

7

8

Pin

Display side
D-sub 9 pin (socket)

4

2

3

5

7

8

20

6

1

Signal nameSignal name Pin

External Device side*
D-sub 25 pin (plug)

User-created cable

Display

Shield

CD

RD(RXD)

SD(TXD)

ER(DTR)

SG

RS(RTS)

CS(CTS)

RTS

SD

RD

CTS

SG

CD

ER

DSR

FG

Display side
Terminal block

4

2

3

5

7

8

20

6

1

Signal nameSignal name Pin

External Device side*
D-sub 25 pin (plug)

User-created cable

Display
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Cable Diagram 5

Display

(Connection Port)
Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module 
(COM1)
ST3000*2 (COM2)
LT3000 (COM1)
IPC*3

5A
RS422 cable by Pro-face

CA3-CBL422/5M-01 (5m)

Turn ON the 
termination resistance 
switch on the External 
Device.

Set the operation 
MODE to 3.

5B

COM port conversion adapter by Pro-face
CA3-ADPCOM-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

5C

COM port conversion adapter by Pro-face
CA3-ADPCOM-01

+
422 cable for GP by Pro-face

CA3-CBL422-01 (5m)

5D User-created cable

GP3000*4 (COM2)

5E

Online adapter by Pro-face
CA4-ADPONL-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
Turn ON the 
termination resistance 
switch on the External 
Device.

Set the operation 
MODE to 3.

5F

Online adapter by Pro-face
CA4-ADPONL-01

+
422 cable by Pro-face
CA3-CBL422-01 (5m)

5G

Online adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

GP-4106 (COM1)
GP-4116T (COM1)

5H User-created cable

Turn ON the 
termination resistance 
switch on the External 
Device.

Set the operation 
MODE to 3.
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5A)

* Turn On the termination resistance switch of the External Device, and set the operation mode to 3.

GP4000*5 (COM2)
GP-4201T (COM1)
SP5000*6 (COM1/2)
SP-5B00 (COM2)
ST6000*7 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000*8 (COM2)
PS6000 (Basic Box) 
(COM1/2)

5I

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1*9

+
User-created cable Turn ON the 

termination resistance 
switch on the External 
Device.

Set the operation 
MODE to 3.

5A
RS422 cable by Pro-face

CA3-CBL422/5M-01 (5m)

5C

COM port conversion adapter by Pro-face
CA3-ADPCOM-01

+
422 cable for GP by Pro-face

CA3-CBL422-01 (5m)

5D User-created cable

PE-4000B*10

PS5000*10

PS6000 (Optional 
Interface)*10

5J User-created cable

Turn ON the 
termination resistance 
switch on the External 
Device.

Set the operation 
MODE to 3.

*1 All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 Only the COM port which can communicate by RS-422/485 (4 wire) can be used.  (Except PE-4000B, PS5000,                 
and PS6000)

" IPC COM Port" (page 4)

*4 All GP3000 models except GP-3200 series and AGP-3302B

*5 All GP4000 models except GP-4100 Series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*6 Except SP-5B00

*7 Except ST-6200

*8 Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display                  
side of the cable diagram.

*9 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block             
Conversion Adapter, refer to Cable Diagram 5B.

*10 Only the COM port which can communicate by RS-422/485 (4 wire) can be used.
" IPC COM Port" (page 4)

Display

(Connection Port)
Cable Notes

External Device*

CA3-CBL422/5M-01

Display

Signal name

RDA

RDB

SDA

SDB

SG

FG

Signal name

SDA

SDB

RDA

RDB

SG

FG
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5B)

* Turn On the termination resistance switch of the External Device, and set the operation mode to 3.

5C)

Do not connect the FG terminal of CA3-CBL422-01 to the External Device.

* Turn On the termination resistance switch of the External Device, and set the operation mode to 3.

5D)

* Turn On the termination resistance switch of the External Device, and set the operation mode to 3.

External Device*

CA3-ADPTRM-01 

CA3-ADPCOM-01 

User-created cable

Terminal block Shield

Display

Signal name

RDA

RDB

SDA

SDB

TERM

SG

Signal name

SDA

SDB

RDA

RDB

SG

FG

External Device*

CA3-ADPCOM-01

CA3-CBL422-01

Display

Signal name

RDA

RDB

SDA

SDB

SG

Signal name

SDA

SDB

RDA

RDB

SG

External Device*Shield

Display

Termination 
resistance
100 Ω 1 W

D-sub 9 pin (socket)

Pin

1

2

3

7

5

4

8

9

6

Signal name

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

Signal name

SDA

SDB

RDA

RDB

SG

FG
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5E)

* Turn On the termination resistance switch of the External Device, and set the operation mode to 3.

5F)

Do not connect the FG terminal of CA3-CBL422-01 to the External Device.

* Turn On the termination resistance switch of the External Device, and set the operation mode to 3.

5G)

* Turn On the termination resistance switch of the External Device, and set the operation mode to 3.

External Device*

CA4-ADPONL-01

CA3-ADPTRM-01

ShieldTerminal block

User-created cable

Display

Signal name

RDA

RDB

SDA

SDB

TERM

SG

Signal name

SDA

SDB

RDA

RDB

SG

FG

CA3-CBL422-01

External Device*

CA4-ADPONL-01

Display

Signal name

RDA

RDB

SDA

SDB

SG

Signal name

SDA

SDB

RDA

RDB

SG

External Device*

CA4-ADPONL-01

Display

D-sub 9 pin (plug) Shield

Pin

2

7

3

8

5

1

Signal name

RDA

RDB

SDA

SDB

SG

TERMRX

Signal name

SDA

SDB

RDA

RDB

SG

FG

User-created cable
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5H)

* Turn On the termination resistance switch of the External Device, and set the operation mode to 3.

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.  

5I)

* Turn On the termination resistance switch of the External Device, and set the operation mode to 3.

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

Shield

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

Signal name

SDA

SDB

RDA

RDB

SG

FG

Signal name
External Device*

Termination 
resistance*1

User-created cable

Display side
Terminal block

Display

External Device*

PFXZCBADTM1

User-created cable

Terminal block Shield

Display

Signal name

RDA

RDB

SDA

SDB

TERM

SG

Signal name

SDA

SDB

RDA

RDB

SG

FG
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5J)

* Turn On the termination resistance switch of the External Device, and set the operation mode to 3.

External Device*Shield

Display

Termination 
resistance
100 Ω 1 W

D-sub 9 pin (socket)

Pin

3

4

2

1

5

7

8

9

6

Signal name

Rx+

Rx-

Tx+

Tx-

GND

NC

NC

NC

NC

Signal name

SDA

SDB

RDA

RDB

SG

FG
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6 Supported Device

Range of supported device address is shown in the table below. Please note that the actually supported range of 

the devices varies depending on the External Device to be used. Please check the actual range in the manual of 

your External Device.

Enter the External Device address in the dialog below.

 When [Addressing Mode] is "Direct"

1 Enter [SX No.] (Input/Output Memory) or [CPU NO.] (Standard/Retain/System Memory).

2 Select a device.

3 Enter the address.

• When the communication unit and the Input/Output unit are used at the same time, Input/

Output Memory cannot be used.

For address settings in GP-Pro EX, use Standard Memory and synchronize the Standard 

Memory address with Input/Output Memory address in External Device.

1

2

3
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 When [Addressing Mode] is "Variable"

1 Select a worksheet.

2 Enter the address.

3 When inputting a bit address, select the bit position of bit address.

4 Variable data is displayed. The address can be entered by double-clicking the displayed variable.

"  Making New Variable Data" (page 52)

• The variables where derived data type of 3 or more hierarchies are defined will not be 

displayed.

1

2 3

4
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 Ladder Software

There are SX-Programmer Expert (D300win) and SX-Programmer Standard in the ladder software to be used for 

setting the External Device. The device name differs respectively as follows.

Device Name
SX-Programmer Expert 

(D300wIn)
SX-Programmer Standard

I/O Memory
Input %I X

Output %Q Y

Standard Memory (fast) %MW1.0  -  %MW1.2047 WM0 - WM2047

Standard Memory*1

*1 The number of device items can be increased or decreased by the ladder tool.  This table                
shows the number of default items.

%MW1.2048 -  %MW1.262143 WM2048 -  WM262143

Retain Memory*1 %MW3.0  - %MW3.260095 WL0 -  WL260095

System Memory %MW10.0 - %MW10.511 WSM0  -  WSM511
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6.1 SPH200

 This address can be specified as system data area.         

Device Bit Address Word Address 32bits Remarks

Input Memory
%IX.0000.00 -
%IX.0511.15

%IW.0000 - %IW.0511 *1  *2

*1 Input/Output Memory Address Designation is as shown below.
• Bit Designation

• Word Designation

*2 In Case of “Connected to FFK120A”, This device is not supported.

Output Memory
%QX.0000.00 -
%QX.0511.15

%QW.0000 -
%QW.0511

*1  *2

Standard Memory
%MX.1.0000000.00 -
%MX.1.0008191.15

%MW.1.0000000 -
%MW.1.0008191

*3  *4  *5

*3 Standard/Retain/System Memory Address Designation is as shown below.
• Bit Designation

• Word Designation

*4 Standard and Retain Memory sizes can be changed. However, the total memory size is fixed. (For details, refer                 
to the manual of External Device).

Retain Memory
%MX.3.000000.00 -
%MX.3.004095.15

%MW.3.000000 -
%MW.3.004095

*3  *4  *5

System Memory
%MX.10.000000.00 -
%MX.10.008191.15

%MW.10.000000 -
%MW.10.008191

*3  *5

%IX.0.0

Bit No. (0 to 15)
Address (Word No.)
SX Bus Unit No. (1 to 238)

%IW.0

Address (Word No.)
SX Bus Unit No. (1 to 238)

• Please refer to the SX Bus Unit No. details in the manual of External Device.

%MX.1.0.0

Bit No. (0 to 15)
Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.

%MW.1.0

Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.
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*5 In Case of “Connected to FFK120A”, 
When you write the bit address, the Display reads the word address corresponding to that of the External Device                  
first. Then, it changes the target bit address among the word data once read and returns the word data to the                    
External Device. Note that the correct data may not be written if you change the word address value in the ladder                    
program while the Display reads the data of the External Device and returns it to the External Device.

• When specifying the address of the Eternal Device directly, always use a setting within the 

specified AT range of the ladder software. We recommend using an AT-specified- variable for 

the External Device used on the Display. Please refer to the Micrex-SX Series D300Win 

<Reference> Users Manual by Fuji Electric Co., Ltd. for details of specifying the AT range 

and how to set it. When using a variable that is not AT-specified, variable needs to be imported 

again and screen transfer needs to be executed if ladder program or variable is changed.

• Always use a system area and reading area within the specified AT range.

• Use high performance CPU system area with an address of %MW1.2048 or later.

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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6.2 SPH300

 This address can be specified as system data area.         

Device Bit Address Word Address 32bits Remarks

Input Memory
%IX.0000.00 - 
%IX.0511.15

%IW.0000 - 
%IW.0511

*1  *2

*1 Input/Output memory Address Designation is as shown below.
• Bit Designation

• Word Designation

*2 In Case of “Connected to FFK120A”, This device is not supported.

Output Memory
%QX.0000.00 - 
%QX.0511.15

%QW.0000 - 
%QW.0511

*1  *2

Standard Memory
%MX.1.0000000.00 - 
%MX.1.0262143.15

%MW.1.0000000 - 
%MW.1.0262143

*3  *4  *5

*3 Standard/Retain/System Memory Address Designation is as shown below.
• Bit Designation

• Word Designation

*4 Standard and Retain Memory sizes can be changed. However, the total memory size is fixed. (For details, refer                 
to the manual of External Device).

Retain Memory
%MX.3.000000.00 - 
%MX.3.130047.15

%MW.3.000000 - 
%MW.3.130047

*3  *4  *5

System Memory
%MX.10.000000.00 - 
%MX.10.065535.15

%MW.10.000000 - 
%MW.10.065535

*3  *5

%IX.0.0

Bit No. (0 to 15)
Address (Word No.)
SX Bus Unit No. (1 to 238)

%IW.0

Address (Word No.)
SX Bus Unit No. (1 to 238)

Please refer to the SX Bus Unit No. details in the manual of External Device.

%MX.1.0.0

Bit No. (0 to 15)
Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.

%MW.1.0

Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.
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*5 In Case of “Connected to FFK120A”,
When you write the bit address, the Display reads the word address corresponding to that of the External Device                  
first. Then, it changes the target bit address among the word data once read and returns the word data to the                    
External Device. Note that the correct data may not be written if you change the word address value in the ladder                    
program while the Display reads the data of the External Device and returns it to the External Device.

• When specifying the address of the Eternal Device directly, always use a setting within the 

specified AT range of the ladder software. We recommend using an AT-specified- variable for 

the External Device used on the Display. Please refer to the Micrex-SX Series D300Win 

<Reference> Users Manual by Fuji Electric Co., Ltd. for details of specifying the AT range 

and how to set it. When using a variable that is not AT-specified, variable needs to be imported 

again and screen transfer needs to be executed if ladder program or variable is changed.

• Always use a system area and reading area within the specified AT range.

• Use high performance CPU system area with an address of %MW1.2048 or later.

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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6.3 SPH2000

 This address can be specified as system data area.         

Device Bit Address Word Address 32bits Remarks

Input Memory
%IX.0000.00 - 
%IX.0511.15

%IW.0000 - 
%IW.0511

*1  *2

*1 Input/Output memory Address Designation is as shown below.
• Bit Designation

• Word Designation

*2 In Case of “Connected to FFK120A”, This device is not supported.

Output Memory
%QX.0000.00 - 
%QX.0511.15

%QW.0000 - 
%QW.0511

*1  *2

Standard Memory
%MX.1.0000000.00 - 
%MX.1.1703935.15

%MW.1.0000000 - 
%MW.1.1703935

*3  *4  *5

*3 Standard/Retain/System Memory Address Designation is as shown below.
• Bit Designation

• Word Designation

*4 Standard and Retain Memory sizes can be changed. However, the total memory size is fixed. (For details, refer                 
to the manual of External Device).

Retain Memory
%MX.3.000000.00 - 
%MX.3.262143.15

%MW.3.000000 - 
%MW.3.262143

*3  *4  *5

System Memory
%MX.10.000000.00 - 
%MX.10.065535.15

%MW.10.000000 - 
%MW.10.065535

*3  *5

%IX.0.0

Bit No. (0 to 15)
Address (Word No.)
SX Bus Unit No. (1 to 238)

%IW.0

Address (Word No.)
SX Bus Unit No. (1 to 238)

Please refer to the SX Bus Unit No. details in the manual of External Device.

%MX.1.0.0

Bit No. (0 to 15)
Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.

%MW.1.0

Address (Word No.)
Memory Classification Number (1:Standard Memory, 3:Retain Memory, 10:System Memory)
CPU No. (0 to 7). However, If CPU No. is 0, no data will be appended.
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*5 In Case of “Connected to FFK120A”,
When you write the bit address, the Display reads the word address corresponding to that of the External Device                  
first. Then, it changes the target bit address among the word data once read and returns the word data to the                    
External Device. Note that the correct data may not be written if you change the word address value in the ladder                    
program while the Display reads the data of the External Device and returns it to the External Device.

• When specifying the address of the Eternal Device directly, always use a setting within the 

specified AT range of the ladder software. We recommend using an AT-specified- variable for 

the External Device used on the Display. Please refer to the Micrex-SX Series D300Win 

<Reference> Users Manual by Fuji Electric Co., Ltd. for details of specifying the AT range 

and how to set it. When using a variable that is not AT-specified, variable needs to be imported 

again and screen transfer needs to be executed if ladder program or variable is changed.

• Always use a system area and reading area within the specified AT range.

• Use high performance CPU system area with an address of %MW1.2048 or later.

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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6.4 When Using a Variable

 Usable Device

The table below shows the Base Data Types of usable Variables.

 This address can be specified as system data area.         

Data Type Bit Address Word Address 32bits Remarks

BOOL

Single 
Var

<VARNAME>

- - *1  *2  *3

*1 <VARNAME>: This is the complete "Variable" name including "Worksheet" name and "Structure" name if it              
is a sub element of a structure. Maximum 255 characters including delimiters (‘.’) and address part (e.g. bit                 
position and array information).

e.g. BOOL type single tag in a Global Worksheet:
"CONF.MainResource.Global_Variables.BOOLVAR"

e.g. INT type single tag in a Local Worksheet:
"MainProgram.MainProgramV.INTVAR"

e.g. DINT type bit address: "MainProgram.MainProgramV.DINTVAR.30"
e.g. REAL type 2D array: "MainProgram.MainProgramV.REALARRAY[1].[2]"
e.g. DINT from a TIMER structure:

"MainProgram.MainProgramV.TIMERVAR.PRE"
e.g. BOOL from a User Defined Structure :
"CONF.MainResource.Global_Variables.USERSTRUCTURE_A.MYTIMER.EN"

• You cannot start names with any of the following text:
   LS, USR, SCR, PRT 

*2 Array dimensions: Up to 2D arrays can be created. When a "Variable" is an array, the size is defined.

Range of array elements: -32728 to 32767

Number of array elements: 32768

Usable memory size for 1 variable: Less than 65535 words

*3 BOOL type arrays: The External Device address must start on bit 0. e.g. %MX1.100.0

1D 
Array

<VARNAME>.[0] to 
<VARNAME>.[x-1]

2D 
Array

< VARNAME >.[0].[0] to 
< VARNAME >.[x-1].[y-1]

INT
UINT
WORD

Single 
Tag

< VARNAME >.00 to 
< VARNAME >.15

< VARNAME >

*1  *2
*4  *5

*4 The system data area is initially set up with 16 words of items. If you set up less than 16 words of items, after                       
allocating a 16 word or larger array of tags in the system data area, select only the necessary items. 

1D 
Array

< VARNAME >.[0].00 to 
< VARNAME >.[x-1].15

< VARNAME >.[0] to 
< VARNAME >.[x-1]

2D 
Array

< VARNAME >.[0].[0].00 to 
< VARNAME >.[x-1].[y-1].15

< VARNAME >.[0].[0] to 
< VARNAME >.[x-1].[y-1]

DINT
UDINT
DWORD
REAL
TIME

Single 
Tag

< VARNAME >.00 to 
< VARNAME >.31

< VARNAME >

- *1  *21D 
Array

< VARNAME >.[0].00 to 
< VARNAME >.[x-1].31

< VARNAME >.[0] to 
< VARNAME >.[x-1]

2D 
Array

< VARNAME >.[0].[0].00 to 
< VARNAME >.[x-1].[y-1].31

< VARNAME >.[0].[0] to 
< VARNAME >.[x-1].[y-1]

STRING
Single 
Tag

- <VARNAME> - *1  *6



MICREX-SX Series SIO Driver   

GP-Pro EX Device/PLC Connection Manual 48

To use a variable and Derived Data Type that were set by D300win with the GP-Pro EX, CSV file and IEC file 

need to be imported.

CSV file and IEC file are exported by D300win.

Imported data is saved as variable data.

*5 You can only set variables assigned to addresses %MW.1 or %MW.3 to the system area.

*6 STRING type: Array access is not possible. Also the "STRING" cannot be used as part of a structure.

• The following derived data types are available for address input with GP-Pro EX.

• Array data type

One-dimensional array

Two-dimensional array (an array of arrays)

• Structural data type

Structure

Array of structure

Structure of array

Structure of structure

• When specifying the address of the Eternal Device directly, always use a setting within the 

specified AT range of the ladder software. We recommend using an AT-specified- variable for 

the External Device used on the Display. Please refer to the Micrex-SX Series D300Win 

<Reference> Users Manual by Fuji Electric Co., Ltd. for details of specifying the AT range 

and how to set it. When using a variable that is not AT-specified, variable needs to be imported 

again and screen transfer needs to be executed if ladder program or variable is changed.

• Always use a system area and reading area within the specified AT range.

• Use high performance CPU system area with an address of %MW1.2048 or later.

• Please refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
• Please refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"

• Defined variable data can be used only with this driver. Therefore, variable data defined with 

other drivers cannot be used with this driver. In the same way, variable data defined with this 

driver cannot be used with other drivers.

• When IEC file meets any of the following conditions, it cannot be imported. Correct 

inappropriate conditions and then import the file.

• There are two or more definitions or keywords (e.g. TYPE and END_TYPE) in 1 row. 

(When a line break is inserted in the comment, the case is recognized that there are two or 

more definitions or keywords in 1 row.)

• There is a structure where array variables are defined.

• There is an Alias of basic data type.



MICREX-SX Series SIO Driver   

GP-Pro EX Device/PLC Connection Manual 49

 Setting Items of [Variable] List Dialog Box

Enter the file name of the variable data.

Select data type to be listed.

Select a worksheet where the variable is registered.

Operation buttons. After selecting the data in the 
[List], adding, deleting, or editing can be executed 
here.
[View] indicates the content of data.
[Import] imports variables and data type.

The cursor is moved to the variable, and data type 
and comments are displayed.

Variable, data type, array, and worksheet that are 
registered in the variable data are displayed.
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 Importing Variable and Data Type

1 Set variable, data type, array, and worksheet with D300win. 

Version of D300win that is supported is V3.1.0.0 or later.

2 Select [Export] from the [File] menu and select the data to be exported. 

Data below needs to be exported.

3 Make [Individual Device Settings] dialog box displayed with the GP-ProEX, and put a check to [Use Variable 

Data]. Then click [New].

4 Enter the name of variable data to save the setting in the [Variable Data Name].

Data to be exported Description File type

Cross reference Variable and worksheet CSV

IEC 61131-3 Data type and array IEC
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5 Click [Import] to import CSV file and IEC file that were exported in the Procedure 2.

Import IEC file first followed by CSV file.

6 Confirm the registered data and click [OK].

• When CSV file including variable with the user-defined data type is imported prior to IEC file, 

an error, "Unknown Data Type was found" is displayed and variable is not imported. Import 

IEC file first in order to register the user-defined data type.

• Arrays, structures and parameters whose name length exceeds 30 single-byte characters 

cannot be imported. Set the name length to 30 single-byte characters or less and then import 

them.
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 Making New Variable Data

If variable data is not imported, make variable data using the following procedures.

Making Variable

1 Select "Variables" from the [List Type] of the [Variable List] dialog box.

2 Click [Add] to display [Variable] dialog box.

3 Enter "Name", "Data Type", "Address" and "Comment" and click [OK].

• To add a variable, the worksheet needs to be set.

Make the worksheet before making the variable.

"  Making a Worksheet" (page 55)
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Making Derived Data Type

1 Select "Structures" from the [List Type] of the [Variable List] dialog box.

2 Click [Add] to display [Derived Data Type (Structure)] dialog box.

3 Enter the "Name" of the member and "Data Type" to be included in "Derived Data Type Name" and data type and 

click [OK].
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Making an Array

1 Select "Arrays" from the [List Type] of the [Variable List] dialog box.

2 Click [Add] to display [Derived Data Type (Array)] dialog box.

3 Enter "Array Name", "Data Type", "Start Element" and "End Element" and click [OK].
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Making a Worksheet

1 Select "Worksheets" from the [List Type] of the [Variable List] dialog box.

2 Click [Add] to display [Worksheet] dialog box.

3 Enter "Configuration", "Resource/Program" and "Worksheet" and click [OK].
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7 Device Code and Address Code

Use device code and address code when you select "Device Type & Address" for the address type in data 

displays.

• When using a variable, device code and address code cannot be used.

Device Device Name
Device Code

(HEX)
Address Code

Input Memory %IX/%IW 0083 SX Bus Unit No.  0x1000000 + Word Address

Output Memory %QX/%QW 0084 SX Bus Unit No.  0x1000000 + Word Address

Standard Memory %MX1./%MW1. 0080 CPU No.  0x1000000 + Word Address

Retain Memory %MX3./%MW3. 0081 CPU No.  0x1000000 + Word Address

System Memory %MX10./%MW10. 0082 CPU No.  0x1000000 + Word Address
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8 Error Messages

Error messages are displayed on the screen of Display as follows: "No. : Device Name: Error Message (Error 

Occurrence Area)". Each description is shown below.

Display Examples of Error Messages

"RHAA035: PLC1: Error has been responded for device write command (Error Code: 2 [02H])"

 Error Code Unique for Driver

Item Description

No. Error No.

Device Name
Name of External Device where error occurs. Device name is a title of External Device set 
with GP-Pro EX. (Initial value [PLC1])

Error Message Displays messages related to the error which occurs.

Error Occurrence Area

Displays IP address or device address of External Device where error occurs, or error codes 
received from External Device.

• IP address is displayed such as "IP address (Decimal): MAC address (Hex)".
• Device address is displayed such as "Address: Device address".
• Received error codes are displayed such as "Decimal [Hex]".

• Refer to your External Device manual for details on received error codes.

• Please refer to "Display-related errors" of "Maintenance/Troubleshooting Guide" for a 

common error message to the driver.

Error Code Description Comment

0x10 CPU Error
An error occurs in the CPU and a command cannot be 
executed.

0x12 Command cannot be executed.
Due to CPU's key switch condition, a command cannot be 
executed.

0x23
During transmission 
interlocking

Transmission is interlocked due to a loader command from 
another device.

0x28 During command processing
Requested command cannot be executed because other 
command is in process.

0x2B During other loader processing
Request command cannot be executed because D300win 
loader is in process.

0x2F Initialization incomplete
Requested command cannot be executed because system is 
initializing.

0x44 Memory addressing error Specified address exceeds effective area.

0x45 Memory size over
Address + reading/the number of written words exceeds the 
effective area.
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 Error Message Unique for Driver

Error Code Error Message Description

RHxx128
"(Node Name):The number of specified 
destination module is not existed.(Error 
Code: [Hex])"

Command destination specification error.
Check module is present / online and that the 
configuration is correct.


	MICREX-SX Series SIO Driver
	1 System Configuration
	2 Selection of External Device
	3 Example of Communication Setting
	3.1 Setting Example 1
	3.2 Setting Example 2
	3.3 Setting Example 3
	3.4 Setting Example 4
	3.5 Setting Example 5

	4 Setup Items
	4.1 Setup Items in GP-Pro EX
	4.2 Setup Items in Offline Mode

	5 Cable Diagram
	6 Supported Device
	6.1 SPH200
	6.2 SPH300
	6.3 SPH2000
	6.4 When Using a Variable

	7 Device Code and Address Code
	8 Error Messages



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Gray Gamma 2.2)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.6
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType true
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 150
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /ColorImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 150
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /GrayImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /CreateJDFFile false
  /Description <<


    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000410064006f006200650020005000440046002065876863900275284e8e55464e1a65876863768467e5770b548c62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200036002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef69069752865bc666e901a554652d965874ef6768467e5770b548c52175370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200036002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /CZE <>
    /DAN <>
    /ESP <>
    /ETI <>
    /FRA <>



    /HUN <>
    /ITA (Utilizzare queste impostazioni per creare documenti Adobe PDF adatti per visualizzare e stampare documenti aziendali in modo affidabile. I documenti PDF creati possono essere aperti con Acrobat e Adobe Reader 6.0 e versioni successive.)
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020be44c988b2c8c2a40020bb38c11cb97c0020c548c815c801c73cb85c0020bcf4ace00020c778c1c4d558b2940020b3700020ac00c7a50020c801d569d55c002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200036002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /LTH <>
    /LVI <>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken waarmee zakelijke documenten betrouwbaar kunnen worden weergegeven en afgedrukt. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 6.0 en hoger.)
    /NOR <>
    /POL <>
    /PTB <>


    /SKY <>

    /SUO <>
    /SVE <>
    /TUR <>

    /ENU (Use these settings to create Adobe PDF documents suitable for reliable viewing and printing of business documents.  Created PDF documents can be opened with Acrobat and Adobe Reader 6.0 and later.)
    /DEU <>
    /JPN ()
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


